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BAB 1 

PENGENALAN APLIKASI PERKANTORAN 
 

1.1 Pengenalan Aplikasi Perkantoran (Microsoft Word, Excel, PowerPoint, dan Canva) 

Aplikasi perkantoran adalah perangkat lunak yang dirancang untuk mempermudah berbagai 

pekerjaan administratif, yang mencakup pembuatan dokumen, pengolahan data, presentasi, dan 

desain grafis. Di dunia kerja, aplikasi-aplikasi ini menjadi alat yang sangat penting, karena dapat 

meningkatkan efisiensi, produktivitas, serta memperlancar komunikasi dan kolaborasi antar tim. 

Penguasaan aplikasi perkantoran tidak hanya membantu dalam menyelesaikan tugas sehari-hari, 

tetapi juga memudahkan dalam menyusun laporan, membuat presentasi, dan menyaring serta 

menganalisis data dalam pekerjaan profesional. 

Salah satu aplikasi perkantoran yang paling sering digunakan adalah Microsoft Word, yang 

berfungsi sebagai pengolah kata untuk membuat dan mengedit dokumen teks. Dengan Microsoft 

Word, pengguna dapat membuat berbagai jenis dokumen seperti surat, laporan, artikel, proposal, dan 

bahkan dokumen ilmiah. Aplikasi ini memiliki berbagai fitur untuk membantu pengguna mengatur 

teks, seperti pemilihan font, ukuran teks, serta penataan teks melalui pengaturan alignment dan 

indentasi. Microsoft Word juga memungkinkan pengguna untuk menambahkan elemen-elemen lain 

dalam dokumen seperti tabel, gambar, dan grafik. Selain itu, penggunaan header dan footer dapat 

mempermudah pengelolaan informasi yang konsisten di seluruh dokumen, seperti nomor halaman 

atau judul dokumen. Salah satu fitur penting lainnya adalah Mail Merge, yang digunakan untuk 

membuat dokumen massal, seperti surat undangan atau label alamat, dengan data yang diambil dari 

spreadsheet Excel. Penggunaan Mendeley juga sangat penting bagi mahasiswa dan peneliti dalam 

mengelola sitasi dan bibliografi, sehingga mempermudah pembuatan daftar referensi sesuai dengan 

format yang tepat dalam penulisan akademik. 

Selain itu, Microsoft Excel adalah aplikasi spreadsheet yang digunakan untuk mengelola dan 

menganalisis data secara efisien. Excel menyediakan berbagai fungsi matematika, statistik, dan logika 

yang memungkinkan pengguna melakukan analisis data dengan cepat dan akurat. Salah satu 

keunggulan utama Excel adalah kemampuannya dalam mengelola data numerik, serta menyediakan 

alat untuk membuat tabel, grafik, dan chart. Dengan Excel, pengguna dapat melakukan analisis data 

yang lebih mendalam dengan menggunakan fungsi-fungsi seperti SUM, AVERAGE, VLOOKUP, 

HLOOKUP, dan IF, yang memungkinkan pengguna untuk menghitung, menyaring, dan merangkum 

data dengan mudah. PivotTable adalah fitur yang sangat kuat dalam Excel, yang memungkinkan 

pengguna untuk mengelompokkan, merangkum, dan menganalisis data secara lebih efisien, sehingga 

sangat berguna dalam pembuatan laporan keuangan, analisis penjualan, atau laporan statistik. 

Dengan kemampuan Excel yang luas, aplikasi ini menjadi alat utama bagi banyak perusahaan dalam 

pengolahan data dan pengambilan keputusan berbasis informasi. 

Microsoft PowerPoint adalah aplikasi yang digunakan untuk membuat presentasi yang menarik 

dan profesional. PowerPoint memberikan berbagai fitur untuk membuat slide presentasi dengan 

desain yang mudah disesuaikan dan menarik secara visual. Dalam PowerPoint, pengguna dapat 

menambahkan teks, gambar, grafik, dan video untuk membuat presentasi lebih informatif dan 

dinamis. Salah satu fitur utama PowerPoint adalah template, yang menyediakan berbagai pilihan 

desain yang telah diatur sebelumnya, memungkinkan pengguna untuk membuat presentasi yang 
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konsisten dan menarik tanpa memerlukan keterampilan desain grafis. Animasi dan transisi pada slide 

juga memungkinkan presentasi menjadi lebih hidup, mempermudah penyampaian informasi dan 

menjaga perhatian audiens. PowerPoint sangat penting dalam dunia profesional karena membantu 

individu untuk menyampaikan ide dan informasi dengan cara yang lebih visual dan mudah dipahami, 

baik dalam pertemuan bisnis, seminar, pelatihan, atau bahkan presentasi akademik. 

Terakhir, Canva adalah platform desain grafis berbasis web yang memungkinkan pengguna untuk 

membuat berbagai jenis desain, mulai dari presentasi, poster, infografis, kartu nama, hingga materi 

promosi untuk media sosial. Canva menyediakan berbagai template desain yang dapat disesuaikan, 

memudahkan pengguna yang tidak memiliki latar belakang desain grafis untuk membuat materi visual 

yang menarik. Dengan Canva, pengguna dapat menambahkan berbagai elemen desain seperti teks, 

gambar, ikon, dan grafik dalam satu desain yang konsisten. Canva juga menyediakan berbagai alat 

untuk membuat presentasi visual, dengan menggunakan template khusus untuk slide presentasi yang 

interaktif dan estetis. Selain itu, Canva memungkinkan pengguna untuk membuat desain grafis untuk 

keperluan bisnis atau pribadi, seperti desain spanduk, poster acara, atau materi iklan yang menarik 

perhatian audiens. Platform ini sangat berguna bagi pengusaha, pemasar, dan individu yang ingin 

membuat desain profesional dengan cara yang sederhana dan mudah. 

Secara keseluruhan, penguasaan aplikasi-aplikasi Microsoft Word, Excel, PowerPoint, dan Canva 

sangat penting bagi mahasiswa dan profesional di berbagai bidang. Aplikasi-aplikasi ini tidak hanya 

memungkinkan individu untuk menyelesaikan tugas administratif dengan lebih efisien, tetapi juga 

untuk berkomunikasi dengan lebih efektif, baik melalui dokumen, data, presentasi, atau desain grafis. 

Mahasiswa yang menguasai aplikasi perkantoran ini akan lebih siap untuk menghadapi dunia kerja 

yang semakin terfokus pada penggunaan teknologi digital dan aplikasi berbasis komputer untuk 

menyelesaikan tugas-tugas sehari-hari. 

 

1.2 Pendahuluan Microsoft Word 

Microsoft Word adalah program aplikasi pengolah kata (word processor) yang biasa digunakan 

untuk membuat laporan, dokumen berbentuk surat kabar, label surat undangan, membuat tabel pada 

dokumen, dan sebagainya. Microsoft Word 2016 adalah aplikasi pengolah kata yang memungkinkan 

untuk membuat berbagai dokumen, termasuk surat, resume, dan banyak lagi. Navigasi antarmuka 

word dan terbiasa dengan beberapa fitur yang paling penting, seperti Ribbon, Quick Access Toolbar, 

dan tampilan Backstage. Word 2016 mirip dengan word 2013 dan word 2010. Jika sebelumnya sudah 

menggunakan versi di bawahnya, maka word 2016 tentunya sudah terbiasa. 

 

Memulai Microsoft Word 

Untuk memulai Microsoft Word, kita dapat melakukannya dengan beberapa cara, diantaranya 

ialah: 

1. Klik Start > pilih menu > Word. 
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Gambar 1.1 Icon menu Aplikasi Microsoft Word 

Microsoft Word akan terbuka, selanjutnya kita kenalan dengan bagian-bagiannya. Berikut adalah 

tampilan awal dimulai lembar kerja Microsoft Word 2016. 

 

 

Gambar 1.2 Tampilan Menu Microsoft Word 

2. Mengenal Bagian-Bagian dalam Microsoft Word 

 

Gambar 1.3 Tampilan Menu Microsoft Word 
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Penjelasan: 

1. Quick Access Toolbar: Secara default berisi tombol save, undo, dan redo. 

• Save digunakan untuk menyimpan dokumen 

• Undo digunakan untuk mengembalikan ke kondisi sebelumnya, jadi kalau ada 

pengaturan yang salah dan ingin dikembalikan lagi, klik ini. Undo bisa dilakukan dengan 

kombinasi keyboard CTRL+Z. 

• Redo, kebalikan dari undo, yaitu untuk mengembalikan ke kondisi setelahnya. 

2. Title Bar: Judul / Nama dokumen yang sedang dibuat. 

3. Icon Control Window: Untuk melakukan minimize window, full window / windowed mode, 

dan mengeluarkan program. 

• Minimize window untuk menutup program sementara dengan mengecilkannya ke 

background dan bisa dibuka kembali untuk melanjutkan. 

• Full window/windowed mode untuk membuka program dengan ukuran full layar, dan 

windowed, untuk membuka program dengan ukuran yang tidak full layar sehingga bisa 

membukanya bersamaan dengan program lain di layar yang sama. 

• Tombol silang untuk menutup program. 

4. Tab Menu. 

5. Tell Me: Untuk mencari tools yang diinginkan. 

Fungsi ini bermanfaat sekali ketika kita ingin melakukan sesuatu tetapi tidak tahu letak dari 

perintahnya dimana. Misalnya kita ingin mengatur margin tapi tidak tahu letaknya, jadi kita 

ketikkan saja "margin" di kolom tersebut dan akan langsung muncul pengaturan yang 

diinginkan. 

6. The Ribbon: Berisi sekumpulan tools yang terdapat disetiap Tab Menu. 

7. Vertical Ruler: Penggaris vertikal. 

8. Horizontal Ruler: Penggaris horisontal. 

9. Document Area: Lembar kerja di Microsoft Word dimana kita biasa ngetik. 

10. Vertical Scrollbar. 

11. Status Bar: Berisi banyaknya halaman, banyaknya kata, dan lainnya. 

12. Mode pembacaan dokumen dan pengaturan zoom. 

 

3. Cara Mengatur Tipografi (Mengatur Ukuran Font, Jenis Font) 

Sekarang kita akan mengatur penulisan di Microsoft Word, seperti mengatur ukuran font, jenis 

font, rata baris, dan lain-lain. Barusan teman-teman telah mengetik beberapa baris, sekarang blok 

seluruh tulisan yang telah dibuat, dan sambil dipraktekan. 

Pengaturan dasar tata penulisan terletak pada Ribbon Tab Menu Home. 

 

Gambar 1.3 Jendela Menu Tab Home 

Penjelasan perkotak dari kiri ke kanan: 
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1. Kotak untuk menentukan gaya/jenis font; Kotak untuk menentukan ukuran font / teks; Untuk 

memperbesar font; Untuk memperkecil font; Mengatur penggunaan huruf besar atau kecil 

pada kalimat / teks; Untuk mengembalikan format penulisan. 

2. Untuk mengatur bullet; Untuk mengatur numbering; Untuk mengatur bullet and numbering. 

3. Untuk mengatur teks agar menjorok ke luar; Untuk mengatur teks untuk menjorok kedalam; 

4. Untuk menebalkan teks; Untuk memiringkan teks; Untuk menambahkan garis bawah pada 

teks; Untuk mencoret teks; Untuk membuat tulisan kecil dibagian bawah teks; untuk 

membuat tulisan kecil di atas teks (seperti pangkat contohnya); Menambahkan efek pada 

teks; Menandai teks; Mengatur warna teks. 

5. Mengatur tulisan rata kiri; Mengatur tulisan rata tengah; Mengatur tulisan rata kiri; Mengatur 

tulisan rata kanan dan kiri. 

6. Untuk mengatur spasi. 

7. Menambahkan warna background teks. 

 

4. Cara Menyimpan Dokumen 

Untuk menyimpan dokumen, caranya: 

Klik Tab Menu File > Save, atau dengan menekan CTRL + S pada keyboard. 

 

Gambar 1.4 Menu Save As 

Klik browse, tentukan letak penyimpanannya dimana. 

 

Gambar 1.5 Tampilan Dokumen Penyimpanan 

Masukkan nama filenya dan tentukan jenis filenya. 
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Gambar 1.6 Jenis Dokumen 

Ada banyak jenis file yang terdapat dalam menu ini, diantaranya: 

Namun biasanya pilihan yang banyak digunakan adalah: 

1. Word Document: untuk menyimpan dengan jenis file Word yang sedang dijalankan. (dapat 

diedit kembali) 

2. Word 97-2003 Document: untuk menyimpan dengan jenis file Word 2003. (dapat diedit 

kembali) 

3. PDF: untuk menyimpan dengan jenis PDF. (tidak dapat diedit kembali) 

 

5. Cara Mencetak (Print) Dokumen 

 

Gambar 1.7 Menu Print 

Untuk mencetak dokumen Microsoft Word, 

Klik Tab Menu File > Print, atau dengan menekan tombol CTRL + P di keyboard, lalu klik Print. 

 

1.3 Memulai Bekerja Dengan Microsoft Word 

Memulai Bekerja Dengan Microsoft Word 2016 

1. Menentukan Format Kertas Pencetakkan 

Digunakan untuk menentukan jenis kertas, batas atas, bawah, kiri dan kanan pengetikan dan 

pencetakkan 

Langkah : 
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a. Klik Tab Layout, Klik tombol dialog Page Setup 

 

Gambar 1.8 Menu Layout 

b. Akan tampil 

 

Gambar 1.9 Tampilan Page Setup 

Tab Paper : Digunakan untuk menentukan jenis kertas, contoh : A4, Legal, Leter dll. 

Tab Margin : Digunakan untuk menentukan batas atas, bawah, kiri dan kanan pengetikkan 

atau pencetakan pada kertas 

Margin terdiri dari : 

Top   = Batas Atas  Left  = Batas Kiri 

Bottom   = Batas Bawah  Right  = Batas Kanan 

Orientation terdiri dari : 

Portrait  = Mencetak secara vertical 

Landscape  = Mencetak secara horizontal 

c. Klik Ok 

 

2. Menentukan Format Teks Pengetikan 

Digunakan untuk memformat bentuk teks, berupa : cetak biasa (Rugular), tebal (Bold), miring 

(Italic), garis bawah (Under Line), jenis huruf, ukuran huruf, warna huruf dll. 

Langkah : 

a. Ketik naskah, lalu blok teks/huruf yang akan diformat 

b. Klik Tab Home, klik tombol dialog Font 

c. Klik Tab Font 
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- Pilih Font : Pilih salah satu jenis huruf 

- Pilih Font Style : Pilih style huruf (Regular/Biasa, Bold/Cetak Tebal, Italic/Cetak Miring 

dan Bold Italic/Cetak Tebal dan Miring) 

- Pilih Size : Untuk ukuran besarnya huruf 

- Pilih Font Color : Untuk menentukan warna huruf 

- Pilih Underline Style : Untuk menentukan garis bawah pada huruf Pilih Effects : Untuk 

menentikan efek pada teks 

d. Klik Ok  

Atau : 

a. Ketik naskah, lalu blok teks/huruf yang akan diformat 

b. Klik Icon yang diperlukan seperti di bawah ini : 

 
Gambar 1.10 Menu Home 

  

3. Menentukan Format Paragraph (Jarak Antar Baris Kalimat) dan Perataan Teks 

Digunakan untuk memformat jarah antar baris kalimat. Langkah : 

a. Ketik naskah, lalu blok naskah yang akan diformat 

b. Klik Tab Home, klik tombol dialog Paragraph 

c. Pilih general → Alignment (Untk menentukan perataan teks, yaitu : Left/Rata Kiri, 

Right/Rata Kanan, Centered/Rata Tengah dan Justified/Rata Kiri Kanan) 

d. Pilih Line Spacing : Menentukan jarang paragraph (single/satu, 1.5 spacing, double/dua) 

e. Klik Ok 

 

4. Membuat Daftar Berurut dan Daftar Bersimbol (Bullet and Numbering)  

Digunakan untuk membuat daftar dengan urut disertai angka atau abjad dan simbil/gambar. 

Langkah : 

a. Ketik naskah, lalu blok naskah yang akan diformat 

b. Klik Tab Home 
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Gambar 1.11 Menu Home bagian Paragraph 

c. Klik Combo Box pada Icon Numbering → Pilih salah satu bentuk numbering  

Change List Level : Untuk menentukan tingkatan number 

Define New Number Format : untuk menentukan bentuk number  

Set Number Value : Untuk menentukan awal mulainya number 

d. Klik Combo Box pada Icon Bullet → Pilih salah satu jenis bullet 

Jika tidak ada Klik Define New Bullet → Klik Tombol Symbol → Tentukan jenis font → klik 

salah satu symbol → Klik Ok 

e. Klik Ok 

 

5. Membuat Kolom Koran 

Digunakan untuk membuat naskah menjadi beberapa kolom seperti Koran. Langkah : 

a. Ketik naskah, lalu blok naskah yang akan diformat 

b. Klik Tab Page Layout, klik Combo Box pada Column → More Colums 

 
Gambar 1.12 Menu Layout 

c. Tampil 

 
Gambar 1.13 Menu Columns 
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Pilih Presets : 

Untuk menentukan jumlah kolom yang akan dibuat (one → Satu Kolom, Two → Dua Kolom, Three 

→ Tiga Kolom, Left → Kolom Kiri lebik kecil daripada kolom kanan dan Right → Kolom kanan lebih 

kecil daripada kolom kiri) 

- Number Of Columns ; Untuk menentukan jumlah kolom yang akan dibuat 

- Line Between : Menentukan garis pemisah antar kolom (Jika di check List aka nada garis 

pemisahnya) 

- Equal Column Width : Menentukan lebar antar kolom yang sama besar → Klik Ok 

 

6. Menyisipkan Gambar (Picture) 

Digunakan untuk menambahkan gambar pada naskah. 

Langkah : 

a. Ketik naskah, lalu blok naskah yang akan diformat 

b. Klik Tab Insert, klik Icon Picture 

 
Gambar 1.14 Menu Insert 

c. Pilih This Device: Pilih file gambar dari folder yang diinginkan 

d. Klik Insert 

e. Jika terkoneksi   dengan internet, dapat memilih online pictures dan mengambil gambar 

yang ada dalam internet 

 

7. Mengatur Gambar (Picture) Pada Naskah 

Digunakan untuk mengatur tata letak gambar pada naskah beserta ukurannya. Langkah : 

a. Klik tombol mouse pada gambar 

b. Arahkan kursor / mouse pada Fill handle → tarik pada fill handle untuk mengecilkan atau 

memperbesar gambar 

c. Tarik gambar dengan mouse kearah teks yang diinginkan 

d. Klik kanan tombol mouse pada gambar 

e. Klik tab layout : untuk menentukan format peletakan gambar 

- In line with text :teks akan berada di atas dan di bawah gambar, sebelah kiri dan kanan 

gambar akan kosong 

- Square : teks akan berada di atas, di bawah, di kanan dan di kiri gambar, mengikutu 

betuk kotak 

- Tight : teks akan berada disekeliling gambar dan mengikuti bentuk lekukan gambar 
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- Behind Text : gambar akan ada di belakang teks 

- In Front Of Text : teks akan ada di belakang gambar, sehingga teks yang tertutup 

 

Gambar 1.15 Menu Picture Format 

f. Klik Ok 

 

8. Membuat Tabel Beserta Rumus 

Digunakan untuk membuat daftar dalam bentuk tabel. Langkah : 

a. Klik Tab Insert → Klik Icon Table → Klik Insert Table 

b. Tampil Table Size (Untuk menentukan jumlah kolom dan baris tabel)  

Number of columns : masukkan jumlah kolom 

Number of rows : masukkan jumlah baris 

c. Klik Ok 

   
Gambar 1.16 Menu Insert 

 

9. Menggabung Cell Tabel 

Digunakan untuk menggabungkan dua atau lebih cell secara berurutan. Langkah : 

a. Blok beberapa cell yang akan digabungkan 

b. Klik Tab Layout → Klik Merge Cells pada kotak dialog Merge 
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10. Memformat Judul Pada Kolom Tabel 

Digunakan untuk mengatur letak judul pada kolom tabel. Langkah : 

a. Blok judul yang akan diformat 

b. Klik Tab Layout → Klik Jenis perataan judul pada kotak dialog Alignment 

 

11. Menghapus Cell, Baris, Kolom dan Tabel 

Langkah : 

a. Blok cell → Klik Tab Layout 

b. Klik Delete pada kotak dialog Rows & columns  

Tampil : 

Delete Cells  : Untuk menghapus cell tertentu dari table  

Delete Colums  :Untuk menghapus kolom tertentu dari table  

Delete Rows  :Untuk menghapus baris tertentu dari table 

Delete Table  :Untuk menghapus seluruh table 

  

12. Menyisipkan / Menambah Baris dan Kolom Pada Tabel 

Fungsi : Untuk menambahkan cell baik berupa baris maupun kolom di sebelah kiri, kanan, atas 

ataupun bawah dari suatu cell. 

Langkah : 

a. Blok cell → Klik Tab Layout 

b. Pada dialog Rows & columns Pilih : 

- Insert Above : Untuk menyisipkan cell satu baris di atas cell aktif 

- Insert Below : Untuk menyisipkan cell satu baris di bawah cell aktif 

- Insert Left : Untuk menyisipkan cell satu kolom di kiri cell aktif 

- Insert Right :  Untuk menyisipkan cell satu kolom di kanan cell aktif 

 

13. Memformat Bingkai dan Warna Latar Belakang Pada Tabel (Border and Shading) 

Fungsi : Untuk menentukan bentuk bingkai dan warna cell pada tabel.  

Langkah : 

a. Blok cell atau seluruh tabel → Klik Tab Layout 

b. Klik Properties pada kotak dialog Table 

c. Klik Tab Border : untuk menentukan jenis, ukuran dan warna bingkai 

d. Klik Tab Shading : untuk menentukan warna latar belakang 

e. Klik OK 
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Gambar 1.17 Menu Layout 

 

14. Mengurutkan Isi Tabel 

Fungsi : Untuk mengurutkan isi tabel secara Ascending ataupun Descending berdasarkan criteria 

tertentu. 

Langkah : 

a. Blok seluruh tabel → Klik Tab Layout 

b. Klik Sort pada kotak dialog Data 

c. Tentukan jenis pengurutan 

d. Klik OK 

 

15. Membuat Rumus Matematika Pada Tabel 

Fungsi : Untuk membuat rumus perhitungan matematika.  

Langkah : 

a. Tempatkan kursor mouse pada cell yang akan dibuat rumusnya 

b. Klik Formula pada kotak dialog Data, mis : =a1*b1 

c. Ketikan rumus pada kotak Formula 

d. Tentukan Jenis Number Format 

e. Klik OK 

  

16. Membuat Tabulasi 

Fungsi : Untuk mengatur pelurusan teks atau data numerik relatif terhadap margin dokumen. Tab 

stop adalah titik perhentian yang telah didefinisikan dan berada sepanjang baris pengetikan. 

Langkah : 
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a. Klik Tab Layout → Klik Paragraph → klik Tab Indents and Spacing 

b. Klik tombil Tabs lalu tampil 

 
Gambar 1.18 Menu Tabs 

c. Pada kotak isian Tab Stop Position, ketik posisi tab stop yang anda inginkan. 

d. Pada bagian alignment, beri tanda atau klik salah satu option pilihan berikut : 

- Left  = untuk tab stop rata kiri 

- Center = untuk tab stop rata tengah 

- Right = untuk tab stop rata kanan 

- Decimal = untuk tab stop rata pada titik decimal 

- Bar = untuk pembuatan garis tegak 

e. Pada bagian leader, beri tanda atau klik pada salah satu option pilihan berikut: 

- 1 None   jika tidak memakai karakter pada leader 

- 2 ……..,  jika memakai karakter pendahulu titik 

- 3 ,  jika memakai karakter pendahulu tanda penghubung 

- 4 ,  jika memakai karakter pendahulu tanda garis bawah 

f. Klik tombol Set, untuk memasang tab stop tersebut pada garis mistar. 

g. Ulangi langkah c sampai e untuk memasang tab stop yang lainnya. 

h. Jika ingin menghapus tanda tab stop, klik Clear pada tab stop position yang akan dihapus 

atau Clear All untuk menghapus keseluruhan. 

Selain dengan menggunakan kotak dialog Tabs, dapat dilakukan dengan pengaturan tabulasi 

dengan tombol toolbar Tab Alignment yang terdapat pada sisi kiri ruler. 

Tabel 1.1 Menu Bar 

Toolbar Perintah Keterangan 

 Left Tab Digunakan untuk tab stop rata kiri 

 Center Tab Digunakan untuk tab stop rata tengah 

 Right Tab Digunakan untuk tab stop rata kanan 

 Decimal Tab Digunakan untuk tab stop rata pada titik decimal 

 Bar Tab Digunakan untuk tab stop berupa garis batas tegak 

 

Untuk mengatur tab stop melalui garis mistar, langkahnya adalah sebagai berikut : 

a. Tentukan jenis perataan tab stop yang diinginkan dengan mengklik tombol tab alignment 

yang terdapat pada sisi kiri mistar. 
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b. Arahkan penunjuk mouse ke garis mistar dan klik pada posisi yang diinginkan. 

c. Untuk memindahkan posisi tab stop, drag tanda tab stop ke posisi yang diinginkan. 

d. Untuk menghapus tab stop, drag tanda tab stop ke bawah atau keluar dari mistar. 

 

Gambar 1.19 Garis Mistar 
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LATIHAN 

 

Selamat Mengerjakan!! 

 


